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Chapter 1 - Introduction
The ArboretumDB suite is a collection of Windows programs that can be run on
computers running Microsoft Windows which enables accurate recording of plants
in an arboretum. The main program allows you to save many features of the plants,
including a history of inspections, identification of National Collections and more.
The programs are designed to be simple and intuitive to use whilst providing
powerful recording and querying features.
The ArboretumDB suite integrates with PT-Maplink so that selected plants in the
arboretum can be plotted on large scale maps of the area. The suite includes an
interface utility to simplify the setting up and importing of Plant Survey data gathered
using the PocketGIS Package.
Programs in the ArboretumDB Suite:
ArboretumDB

ArboretumDB – Support Utility

ArboretumDB – Interface Utility

Programs that the ArboretumDB Suite optionally interface with:
PT-MapLink
Pear Technology Ltd.
PocketGIS Connection
Pocket Systems Ltd.
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Chapter 2 - Getting Started
Requirements
The ArboretumDB suite can be run on Windows Vista, Windows 7, Windows 8*
and Windows 10**.
* not RT or Mobile.
** not Mobile.

Preview the ArboretumDB
The installation CD enables an option to run the ArboretumDB without having to
install anything on your computer. A Sample database is accessed directly from the
CD enabling you to see most of the functions of the ArboretumDB. This version is
Read-Only and so won’t allow you to change any data. To test the full functionality
of the program, it will need to be installed and the sample database used.

Installation
All the setup packages are accessible from the ArboretumDB CD which can be
obtained from Pear Technology Ltd.
To install the required package you will need to be logged in as a user with
Administrator rights (or enter an Administrative User and Password when
prompted) and the product will be installed for all users of the pc. Shortcuts for the
installed programs will appear in the Start Menu in a folder called Pear Technology.
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First Use
The first time you run the ArboretumDB program you will need to select a database
to work with. You have three options:
1) Create a new sample database
2) Create a new empty database
3) Select an existing ArboretumDB Database.
These options can be found on the File Menu.
If trying out the program, it's recommended that a sample database is created. This
contains a number of plants and inspections and can be used to see how the
program works and is a safe environment to experiment in. To create a sample
database;
Start the ArboretumDB program and from the File menu, select “New
Database” then “Sample Database”. You will see a “Create New
ArboretumDB Database” dialog, with the file ArboretumDB_Sample.mdb
selected. Save this file into an appropriate folder, say in My Documents. You
can change the file name.
If you choose to create a new empty database then please note that you will be
limited to entering fifty plants without purchasing a license. To create an Empty
database;
Start the ArboretumDB program and from the File menu, select New
Database then Empty Database. You will see a “Create New ArboretumDB
Database” dialog, with the file ArboretumDB.mdb selected. Save this file into
an appropriate folder, say in My Documents. You can change the file name.
You can create both sample and empty databases and switch between them.
Once a database has been created or an existing database has been selected, you will
be taken straight to the Plants List. This will show the various options on the left
hand side and an initially empty Plant List on the right hand side. Initially the list will
be empty, you will need to click the “Find” button to view the plants.
If you already have an ArboretumDB database then you should click the “Select
Database” from the File Menu and select it from the “Select ArboretumDB
Database” Dialog.
If you are planning to share the database with several users then the database should
be saved in a folder that all the required users have access to.
If the database file ( {filename}.mdb ) is flagged as read-only or is in a folder where
you have Read-Only access then the program will allow you to query the database
and view the details but will disable all update features.
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If you wish to have one person maintaining the database but want to allow other
people to view the database (but not change anything) then the best approach would
be to have the database on a network share and ensure that the person updating the
database has read-write access and the other people have read-only access.
If you have multiple databases then the program will remember the eight most
recently accessed. You can then quickly switch between the different databases using
the File / Recent Databases menu.
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Chapter 3 – Core Functions
Plants
The plants screen is initially shown when you start the program or can be shown
from the “View” menu. This is one of the two main screens that allow you to query
the plant information stored about your arboretum.

The system is now waiting for you to select what you want to view and the results
will be displayed on the right hand side. For example just clicking the “Find” button
with no further refinement will show all Plants in the database (this may take a few
seconds if you have thousands of plants in your arboretum).

You can select what columns are shown in the list using the “List Details” Button.
On the left hand side we can see how many plants we have selected (2403 in this
case) and how many of those have been recorded as dead (140 in this case). To view
more of the list you can hide the left-hand panel using the small thumbnail next to
the Find Button.
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Once we have some plants in the list we are able to do a number of options:
“Plant” Button – will display the form with all the information recorded about the
plant. See Plant Details below for more information.
“Inspection” Button – will show the latest inspection for the highlighted plant.
(See Inspections, later in this chapter).
“Add” Button – will display an empty plant form for adding the plant.
“Delete” Button – will display the current plant for confirmation before delete.
“Print” Button – will pop up a form asking the details to include in the print and
then create a html page and display it in your default browser. From there it’s simple
to print it or save it for other uses.
“Export” Button – this will allow you to create either an excel spreadsheet (see
Chapter 2 – Getting Started) or a csv file (for compatibility with other spreadsheet
applications or mail merge systems). Clicking the “Export” button will pop up a
dialog asking what properties you would like to include on the export (which will be
remembered for next time you export Plants). There is also a button “PocketGIS
Export” which can be used to generate a CSV file for exporting to a PocketGIS
device (see ArboretumDB Interface Utility),
“Map Button” – If PT-Maplink is installed then clicking this button will plot the
plants in PT-Maplink, complete with the plant information currently shown in the list
allowing the viewing of the properties of individual plants by clicking the plant on the
map. (See Settings later in this chapter for information on how to configure this
option.)

Plant Details
Once a plant has been selected from the list it’s details can be viewed by clicking the
Plant Button. Additionally the details will be shown when attempting to delete a
plant or adding a new plant. The Details form has six Tabs:
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Nomenclature:

Details:

Description:
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Origin:

Collections:

Pictures:

The Detail form also includes buttons for viewing the Previous and next plant in the
Plant List
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Printing
The print button will generate an html file and display it within your default browser.
From there you can either print it or save it.

When Adding a Plant you will need to select a Block and a Plant Number (or select
the Next Plant Button to allocate the next available number in the block).
To assist with entering the Nomenclature and Common Name, there are two Find
buttons. If you enter the common name and click the adjacent Find button it will
display a list of possible Genus/Species which if selected will populate the
Nomenclature. Alternatively selecting Family and optionally genus then clicking the
adjacent Find button will list the possible matches and will populate the common
name where possible. When adding a cultivar, don’t enclose the cultivar in single
quotes, these will be added automatically for the Botanical Name (eg. enter
Jacqueline Hillier rather than 'Jacqueline Hillier' for an Ulmus x hollandica, the
Botanical Name would then be generated as Ulmus x hollandica 'Jacqueline Hillier').
You can assign the plant to any number of Collections / Plant Groups. For example if
the plant is part of a National Collection. Collections are a very powerful way of
grouping plants (see the Settings later in this chapter).
It’s possible to associate pictures with the plant. The picture is not stored in the
database but the picture’s filename and a caption is recorded in the database. The
default folder for pictures can be set in the Database Settings. If a picture is recorded
then the View button will display it. If you are sharing the database between multiple
users on the same or multiple computers then the location of the picture file must
be accessible to all users and must have the same shared path name for all users.
There is a Button “Change Status” on the form. This is for when you want to retain
the record of a plant but it has been Felled, Removed or converted to a Monolith.
This also restricts what information can be recorded about the plant.
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At the bottom of the form, along with the Save and Cancel buttons, there are two
extra buttons. The Map button will display the position of the plant using PTMapLink (if installed) and the Report button will display a report with the plant
details and the latest inspection details.
When you save an existing plant or add a new
one, you will be asked if you would like to:
1 – Skip Inspection
2 – Add a new Inspection for this Plant
3 – Edit the latest Inspection for this Plant.
(see later in this chapter for inspections)
Plant Selection/Filtering Techniques
At the start of this chapter we just
clicked the Find button to show all the
plants in the database. This can be quite
slow when there are a lot of plants in the
database. The Plant List has a flexible
system for filtering the results to show
only those plants you are interested in.
For example you could select a single
block to list the plants in that block or
select an Age Class. More than one filter
can be select at a time so you could list,
say, all your Condition Red (v poor)
Quercus species plants.

You may also choose a Collection. This is a very powerful way of grouping plants, for
example for recording a National Collection or a group of donated plants etc.
Filtering what is displayed in the list will not only speed up finding the plant you are
looking for but it also allows you to print, export or map your selected plants. For
example, export all plants in a specific National Collection to a spreadsheet, or plot
on the map all your Condition Red plants.
Many of the drop down lists in the program can
contain a lot of information. For example selecting
“Sorbus” from the Genus list requires a lot of scrolling.
However you can quickly select the Genus you want
by starting to type the name in the box and this will
display only those Genera staring with the letters you type, then click on the one
you want. This works for all drop down lists in the ArboretumDB.
Finally, there is a Reset Button that clears all the filters and the plant list ready for a
new query.
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Inspections
The Inspections List works in a similar way to the Plants List with similar filtering. By
default the list will only include the latest inspection for each plant. If you want to list
the full history of inspections for a plant then select the Block and plant number then
select “All Inspections” in the Inspections Tab then click the “Find” Button.

All the buttons work in the same was as on the Plants List.
There is a new button “Req. Work” which produces a Print Preview including each
plant in the list complete with the work required (if any) as identified in the latest
inspection. This button is best used in conjunction with the Extra Option “Required
Work” with the value “With Required Work”.

To Generate a Map with the location of the Required Work, use the Plants screen
with the Extra Option “Required Work” with the value “With Required Work” and
then click the map button.
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When adding an
inspection you will need
to select the Block and
plant then click the select
button. The values will
then default to the
details found in the last
inspection for that plant
so that you only need to
enter what has changed.
The inspection date will
default to today’s date.

Multiple “Work
Required” codes can be
selected along with a
“Work Timeframe”
when adding or changing
an inspection.

Risk Assessment details
can be recorded on the
Risk Assessment Tab.
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Risk Assessment
The Risk Assessment List works in a similar way to the Plants and Inspections Lists
with similar filtering. The List can be printed, exported or displayed in PT-MapLink (if
installed). The Inspections button will show the Plant in the Inspections List. The
details of a Risk Assessment can be viewed/changed in the Inspection Details form.
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Work Schedule
The main function of the Work Schedule is to provide a simple way to identify work
required from plant inspections, to allocate the work to staff and record the work
being completed.
Plants Requiring Work

This screen lists all the plants whose latest inspection has identified work required.
You can then allocate this work to members of staff by checking the Selected box
for each plant, selecting someone in the “Who” drop down list, selecting a date and
clicking the “Save” button. Once the work is allocated for a plant it will no longer
appear in this list.
If work on a plant is no longer required then the plant or plants can be highlighted as
before and then clicking the “Remove” button will remove them from this list.
This program uses data held in the database but will not affect nor change the data as
viewed from the main ArboretumDB program.
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Scheduled Work
The Scheduled work screen can be accessed via the “View” menu.

This screen shows the work allocated to a member of staff (as chosen from the
“Who” drop down list. Three actions can be performed on this list: Export to a
spreadsheet (Excel if available or csv), Plotted on a Map (if PT-Maplink is installed) or
Printed as a work sheet:
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It’s possible to add new work using the “Add” button. This adds work to the Work
Schedule. It does not create a new inspection record in the ArboretumDB database.

When the work has been completed, you can select the appropriate plants using the
check boxes, select the date the work was completed and click the save button.
Completed work will no longer appear in the list. Completed work can be shown by
selecting the “Include Completed Work” checkbox before clicking the “Find”
button.
The Scheduled Work Screen can also be used to show the history of work done
which can be limited to a specific plant if required.

There is an option on the View/Maintenance menu for Work Schedule Maintenance.
“Remove old inspections from the Available Work List” before an inspection date.
“Remove old completed work from the Work Schedule List” before a completed
date.
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Properties
There are several screens for managing various properties that are used throughout
the ArboretumDB database.
These are:
Blocks
Blocks can be used to group plants in defined areas of your arboretum. You must
have at least one block to hold the plants in the database.
Collections
Collections are a powerful way of grouping plants together. This can be to record
the plant is part of a national collection, one of a number of plants donated by a trust
or just about any group of plants.
Family & Genera
These are used for maintaining the list of families and their associated genera.
Common Names
This form matches Family, Genus and Species to the associated Common Names.
Age Class & Condition
These forms allow the maintenance of the standard values for Age Class and
Conditions of plants. An extra feature of these forms is a value called Display Order.
This is a way of indicating what order these values are displayed in the drop down
lists. For example, it would be logical to have the conditions listed as Green, Blue,
Gray and Red rather than them being displayed in alphabetical order.
Required Work & Timeframe
These two properties are used for inspections; several required work codes can be
checked for an inspection along with a timeframe.
Plant Status
Plant status can be used to indicate the removal, felling or the creating of a monolith.
This enables a small subset of plant and inspection properties to be used for a plant.
This can be used to keep inspections for a monolith or to record the position and
details of a removed tree. Other Plant status can be added as required. An option is
available to indicate whether the GPS location for the plant is to be retained for each
Plant Status.
Risk Zoning, Inspection Type and Acceptability
These three options are for maintaining the lookups for the Risk Assessment feature.
Staff
Staff allows you to manage staff or contractor names for use in scheduling work.
Climate Zones, Soil Types and Vegetation Regions
These three options are for maintaining the lookups for plant origin.
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Settings
The ArboretumDB Settings are split into Registration Settings, Database Settings and
User Settings and can be accessed from the “View” menu. The database settings will
be used for all users accessing that specific database. User settings will be saved for
each individual user and will apply to all ArboretumDB databases that are accessed.
Registration Settings
This is where you store the registration details for your Arboretum when
purchased. It is recommended that you copy & paste the details using the clipboard.

Database Settings
Database settings are saved in the database and are set for all users of that database.

The “Report Tag Line” can only be set for registered databases. This will be included
on the reports. In unregistered databases a default Report Tag Line is used.
The Display Options sets whether Plant Numbers are to be displayed with leading
zeroes or not. If this is set then the number of digits in the Plant Number can be
chosen (e.g. 032, 0032, 00032 or 32 if the leading zeroes option is not set).
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A Default folder can be set for Pictures. This folder will be used as the default folder
when adding a new picture to a plant. It does not force the pictures to be in this
folder, it’s simply a default “suggested” folder. The full filename of the picture will be
held in the database.
Height, Crown, Girth and Diameter measurements can be set to a specified number
of decimal places.
The Corner Coordinates define the bounds of the Arboretum using two coordinates
(Eastings and Northings for the Bottom Left and Top Right). This is used for the GPS
Check Function and for the PocketGIS Interface. For example if the bottom left
Grid Ref is SJ 79300 66700 and Top Right is SJ 80300 67400 then the Corner
Coordinates would be: 379300,366700,380300,367400. These values are in metres.
There is a “Show Grid” button with shows the National Grid to assist with
converting the two character prefix for Eastings and Northings.
If the PocketGIS software is installed on your system then you can enter the Schema
Name and coordinates. See Chapter 7 – ArboretumDB Interface utility.
User Settings
User settings are preferences for each user of the database.
The miscellaneous
option allows the use to
decide whether he wants
the “Required Work
Timeframe Summary” to
be displayed each time
the ArboretumDB
program is started.

If PT-Maplink is installed on the computer then you can save various settings for use
when displaying the plants with the PT-Maplink program launched from the
ArboretumDB.
The PT-Maplink Global options will be used when plotting on any map. The “Use
Secondary ID” option can occasionally slow down the rendering of the map, but
allows more flexibility in searching for plants on the map where the Plant IDs are
very long. This option should usually be unset.
If you have multiple databases the PT-Maplink Map file can be set for each. You will
be able to choose the correct Map file for the database you are currently connected
to (Example Arboretum) in the above example. If you connect to another database
then the PT-Maplink Map file for that database can be set.
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Chapter 4 – Other Features
There are a number of additional features that can be found on the “View” Menu.
Arboretum Summary
This screen shows summery information about the database:
The name and location of the database file.
Date and Time the database was last updated.
The number of blocks in use (i.e. with at least one plant)
The number of plants recorded in the database
The number of dead plants
The number of labelled plants
The number of plants with pictures
The number of distinct species
The number of Felled, Monoliths and Removed plants
The number of plants in each collection
The Arboretum Summary information can be exported to a spreadsheet or printed.
Plant Summary
This screen shows a summary of Family, Genus, Species or Botanical Name in the
database. This can be exported to a spreadsheet or printed.
BGCI Plant Data
This screen generates a list of the distinct plants in the arboretum in the format
required by the BGCI for upload. This can be exported to a csv file.
Required Work Timeframe Summary
This screen lists the number of plants with Required Work in each Timeframe. This
screen can be set to be displayed each time the program is started. There are
buttons to show these plants in either the Plant view or the Inspections view.
Maintenance
There are two options under the Maintenance menu.
“Remove a Block (including Plants)”: This is for deleting whole blocks and the plants
and inspections that they contain. This option is only available with a registered
database and should be used with caution.
“Work Schedule Maintenance”: This option enables the removal of Old Inspections
from the Available Work List and the removal of old work completed from the
Work Schedule.
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GPS Check
This option lists the
Plants where the GPS
value lies outside the
bounds of the arboretum
as defined by the Corner
Coordinates on the
Database Settings Form.
This quickly shows plants
where the GPS value
may be incorrect. This
option is only available if
the Corner Coordinates
have been correctly set.

The Help Menu
There are two options under the Help menu.
“View Manual” – will display this manual. The manual is saved as a PDF document
and will need an appropriate reader to be installed on your system (such as Adobe
Reader, Foxit Reader, PDF XChange Viewer etc.
“About” – Displays information relevant to both the program and database in use.
This form also displays
the time the database
was last updated.
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Chapter 5 – ArboretumDB Support Utility
The support utility is used for a number of miscellaneous functions.

The “Backup Database” button will create a zip file backup of the database. This can
be used for periodic backup or for sending a copy of the database to a remote
location via the internet or on disk.
The “Restore Database” button will restore a database previously backed up using
this utility. When restoring a database the utility will warn you if the database you
are restoring has been updated since the backup was taken.

The “Repair Database” button can be used if there is a problem with your database.
It should be used if indicated to do so by support staff.
The “View Errors” button can be used to create a text file that can be sent to
support, should get unexpected errors when using the program. It may take a few
minutes for this option to filter the ArboretumDB messages from the Windows
Event Log. This file contains details of the error screens that have been displayed for
the ArboretumDB programs. This will help support staff in identifying the problem.
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Chapter 6 – ArboretumDB Interface Utility
The ArboretumDB Interface Utility is another program in the ArboretumDB
program suite. It is presented as a separate install package and adds a new link under
Pear Technology on your start menu.
This utility is a program to automate the import of data from the PocketGIS Device
and to manage the PocketGIS Schema. It enables a simple way to gather the
collected data from the PocketGIS and import it into the ArboretumDB.
Before running the Interface Utility, you must first ensure that the two “Other
Settings” are set correctly using the Database Settings option of the ArboretumDB
program. These settings will define the bounds of the Arboretum and the Schema
name that the PocketGIS Connection program will use. See Chapter 3 for details.

The Interface Program has four tabs defining the functions:
Configuration, PocketGIS Export, PocketGIS Import and CSV File Import.

The first tab “Configuration” confirms which ArboretumDB database you are
connected to. You will need to use the ArboretumDB program to switch between
different databases then click the Refresh button which will confirm the database
that you are connected to. This is important as the interface uses the settings from
the database when communicating with the PocketGIS and when importing data into
your ArboretumDB database.
The first time the ArboretumDB Interface utility is run, it will be necessary to
confirm the location of the “PocketGIS Connection program” using the button.
Note: The rest of this document assumes that you are familiar with the use of the
PocketGIS device and software and are familiar with how to connect the device to
your computer.
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PocketGIS Export

There are two options to send data to the PocketGIS. Both will create a new
Schema for the PocketGIS containing details of your blocks and the necessary
lookups for use on the PocketGIS device. One option allows you to attach a
previously created csv file containing plant data (using the ArboretumDB PocketGIS
Export feature) and send it with the schema to the PocketGIS. In either case the
Schema will be connected to the currently selected View on your PocketGIS device.
This process will delete all previously collected data for this Survey on your
PocketGIS.
Connect your PocketGIS device with ActiveSync or Mobile Device Centre.
1,
2,
3,

Run the PocketGIS program on your PocketGIS Device.
Select the appropriate view for the Selected Survey
In the Interface utility
either Click “Update Schema and Send to PocketGIS”
or
Click “Update Schema, Load Plant Data and Send to PocketGIS”.

This will automatically run the “PocketGIS Connection” program to make the
transfer so that the appropriate lookup information for your arboretum is setup on
the device (such as your Block List, Required Work List etc.) and optionally the
selected Plant Data.
Note: If you change any of the properties in your database such as adding new
blocks, then you will need to perform this function so that the PocketGIS device has
up to date information. Care should be taken that the data on the PocketGIS is
updated before using it for a survey and the data from the survey should be
uploaded to the ArboretumDB before any updates are made to the data in the main
ArboretumDB program or there is potential for newer data being overwritten by
older data.
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Importing data from the PocketGIS

There are two options to choose when getting data from the PocketGIS.
Firstly you can decide to get all data from the PocketGIS data or only the data that
has been added since the last time you got the data. Usually you would check this
option to only upload data changes since last upload.
Secondly you can choose to get the data from the PocketGIS but not import it into
your ArboretumDB database. This will save the data as a csv file which can be
imported into the database using the CSV File Import Tab.
To Get the Survey data from the PocketGIS and import it directly into your
ArboretumDB database you need to follow the steps below:
1.
2.
3.

Ensure you are connected to the correct ArboretumDB database.
Usually you would select “Only include changes since last upload”.
Click the “Import Data from PocketGIS” button.

This will automatically run the “PocketGIS Connection” program to get the data
from the PocketGIS. This will then display the records that are being imported in the
grid (see above image. As the records are imported the program will highlight the
record that is being processed.
Once the import process has completed any rejected records will be displayed in the
grid. Each rejected record will give the reason in the right hand column.

Additionally a csv file will be created on your desktop which will contain this
information. This is in the same format as the import file with the addition of the
Validation Error column. This file can be edited to correct the problem and then
imported using the CSV File Import Tab. The name of the file will be the name of the
PocketGIS Survey appended with _errors.csv. In the above example the filename
would be “Example Survey_errors.csv” and would be located on your desktop.
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There are a few things to note when using the
PocketGIS.
If you survey a plant which is already in the
ArboretumDB database then the information you
enter will be used to change the existing record.
Anything you leave blank will not be set to blank on
the database; the existing information will be used.
If you set the Plant Number to 0 [zero] (i.e. a new
plant not previously entered into the database) the
Interface program will automatically allocate the next
Plant number within the Block as it is imported.
Importing data from a CSV File

The fourth Tab is for importing data into your ArboretumDB. The format of the csv
file is the same as that produced by the PocketGIS connection for the ArboretumDB
Survey schema. It can be used to import appropriately edited Error files produced by
the PocketGIS Import Tab.
It is possible to use this import with csv files sourced from other applications,
however ensuring exactly the correct format is quite difficult and as such is beyond
the scope of this Manual.
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Major changes since version 4.5
Project upgraded to Visual Studio 2013 and Microsoft’s Dot Net Framework 4.5
Database structure revised.
Significant optimisations have been made to speed up the display of Lists and when
sorting columns.
The search Criteria for Plants and Inspections have been improved by introducing a
tabbed container for options.
Plant and Inspection Lists now have a slider button to hide /show the left hand panel
allowing more columns in the list to be shown on screen.
The Plant List now has a button to take you directly to the inspection details for the
selected plant.
When viewing the details of a plant, there are buttons to move to the Next /
Previous plant in the list.
Plant Details – new tab for “origin” which includes ‘Where Collected’, ‘Altitude
found’, ‘Soil Type’, ‘Climate Zone’, Vegetation Region’ and ‘Environment Notes’.
Collection name is now longer (up to 100 characters).
Plant Summary now has new option for Full Botanical Name.
The link to PT-MapLink now used an Excel Spreadsheet. The map now only shows
the details that are in the Plant List.
All printing is now done by generating an HTML file. When printing Lists, you can
choose what is displayed.
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Feedback
We welcome any feedback on the manual. This is a work in progress and we hope
to improve the quality of the information in this manual and your help is an
important part of that process.
Feedback can be made via a form on the contact page of the ArboretumDB website:
www.arboretumdb.co.uk or by email to rob@arboretumdb.co.uk
Manual Last Updated: 8th July 2015 by Rob McIntosh.
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